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Connecting Your Camera to Your Computer 

Before you can start editing video with Windows Movie Maker 2 for Windows XP, you 
have to make sure you’re set up with the right hardware. 

Because there is such a wide variety of hardware available, it is impossible to detail 
every possible configuration. The following list describes some of the basic capture 
devices and explains how to connect them to your computer. Depending on the 
capture device and associated hardware you have on your computer, you could use 
none, one, or several of the listed configurations. 

Digital Camera Connected to an IEEE 1394 Card 

To get the best quality from your digital video (DV) camera or mini–DV camera, you 
should have an IEEE 1394 capture card installed on your computer. An IEEE 1394 
card is a piece of hardware that passes the information from the DV camera to your 
computer. Because the data is already in digital form, it can be read and transferred 
directly to your computer without any processing or conversion. That means you'll 
enjoy the highest–quality video that is possible with a consumer video camera. 

 

Figure 3-1.  Connecting a DV camcorder to an IEEE 1394 capture card. 

Downloading Video to Your Computer 

Once you have your hardware configured, you can capture video and audio to your 
computer. Using Movie Maker 2 with Windows XP, it's easy to capture video and 
audio from tape or live action. This article explains how. 

Capture Video from a Tape in a DV Camera 

Connect your DV camera to your computer; as discussed earlier, in most cases this 
requires an IEEE 1394 adapter on your PC and an IEEE 1394 cable to connect your 
camera. On the camera, set the camera mode to play the recorded video. (This is 
often labeled VTR or VCR on a DV camera.)  

Start Movie Maker. To start Movie Maker, click Start, point to All Programs, point 
to Accessories, and then click Windows Movie Maker.  



On the File menu, click Capture Video. Alternatively, in the Movie Tasks pane, 
under Capture Video, click Capture From Video Device.  

On the Video Capture Device page, in Available Devices, click the DV camera.  

In the Enter A File Name For Your Captured Video box, enter a name for your 
captured video file. Then, in the Choose A Place To Save Your Captured 
Video box, select the location where you want your video to be saved, or click 
Browse to select a location.  

On the Video Setting page, choose the video setting you want to use for capturing 
video and audio.  

On the Capture Method page, click Capture The Entire Tape Automatically. The 
tape in the DV camera will rewind. Capture will begin automatically and ends 
when the video tape ends.  

Select any of the following commands:  

• To separate the video into smaller clips, select the Create Clips When 
Wizard Finishes check box.  

• To stop capturing before the end of the video tape, click Stop Capture, 
and then click Yes in the resulting dialog box to save the video that has 
been captured.  

 To close the Video Capture Wizard, click Finish.  

The captured content will be imported into a new collection with the same name as 
the specified video file. 

Capture Parts of a Video from a Tape in a DV Camera 

If you want to capture parts of a video from a tape on your DV camera, rather than 
the entire video, perform the first five steps in the procedure above, and then the 
following steps: 

1. On the Capture Method page, click Capture Parts Of The Tape Manually.  

2. To separate the video into smaller clips, select the Create Clips When Wizard 
Finishes check box.  

3. To prevent audio from playing while capturing video, select the Mute Speakers 
check box.  

4. Locate the video and audio you want to capture from your tape by using either 
the controls on your DV camera or VCR or the DV Camera Controls in the wizard.  

5. To begin capturing video, click Start Capture. The tape will play automatically and 
capture will begin.  

6. When the tape reaches the point at which you want to stop capturing, click Stop 
Capture. Repeat these steps for each part of the video tape that you want to 
capture.  



7. When you have finished capturing, click Finish to close the Video Capture Wizard.  

The captured content will be imported into a new collection with the same name as 
the specified video file. 

AutoMovie Makes It Easy 

Once you have captured video onto your computer, you’re ready to make your own 
movies. Windows Movie Maker 2 has a new built-in feature called AutoMovie, which 
does exactly what its name implies: it automatically makes a home movie for you. 
Now, you can create great home movies with just a few clicks. All you have to do is 
select the footage, select an audio track, and choose an editing style. AutoMovie 
does the rest. It analyzes the selected video, pictures, and music, and combines the 
different elements with transitions and effects to make a movie. 

Best of all, AutoMovie will create a storyboard and timeline for you, so if there's 
anything you want to change about your AutoMovie, you can easily do that later. 

When using AutoMovie, you must first complete the following steps:  

• Select a clip collection or choose multiple individual clips in the Collections 
pane or Contents pane.  

• Make sure the clips you chose contain video and/or pictures, as well as at 
least one audio clip.  

• Make sure the audio clip is long enough to play for the total duration of all of 
the clips you've selected.  

To use AutoMovie: 

1. Select a collection or multiple clips in the Contents pane.  

 On the Tools menu, click AutoMovie. 

Or: 

2. In the Movie Tasks pane, under Edit Movie, click Make an AutoMovie.  

3. In the Select An AutoMovie Editing Style dialog box, click on a style.  



 

Figure 3-7. Select an editing style. 

 Under More Options, click Enter A Title For The Movie.  

4. In the Enter Text For Title dialog box, type the text you want to appear as the 
title.  

5. Under More Options, click Select Audio Or Background Music.  

 

Figure 3-8. Add audio and music files. 

 Under Audio And Music Files, do one of the following:  

• Select an audio or music file from the current list.  



• Click Browse to import an audio or music file on your hard disk into 
Windows Movie Maker 2 to use in your movie.  

• Select None if you do not want any audio or music added to your movie.  

 If your movie will include audio or music, you can do one of the following:  

• To increase the audio level of an audio clip on the Audio/Music track, 
drag the slider bar towards Audio/Music.  

• To increase the audio level of the audio on the Audio track that is part of 
a video clip, drag the slider bar towards Audio From Video.  

 Click Done, Edit Movie to create the AutoMovie and add the clips to the 
storyboard/timeline. 

The time it takes for the AutoMovie to be processed and added to the 
storyboard/timeline depends on the duration of the movie, and the size of the audio, 
video, and picture files. Generally, it will take about 1/3 the time of the overall length 
of the clips to complete the process. 

Creating a Movie 

Windows Movie Maker 2 makes it easy for just about anyone to make movies on their 
computer. Chapter 3 showed you how to use Movie Maker’s AutoMovie feature to 
automatically generate a movie with an audio track, transitions, and video effects. 
When you use AutoMovie, most of the directorial decisions are made for you. 

But you can also have complete control over your movie, from building the storyboard 
to editing clips, to selecting and adding transitions, effects, titles, music, and 
narration. This chapter will show you how, as well as how to save and share your 
finished movie. 

Build a Storyboard 

Movie Maker automatically divides your video into segments to make it easier to drag 
and drop the parts you want onto the storyboard where you put your movie together.  

To build a storyboard: 

6. Import video to your PC. You’ll see your clips in the Collections view.  

7. Double click on each clip to see how it looks in the preview window.  

 Once you’ve decided which ones you want to put in your movie, click and 
drag the clips to the Storyboard in the order in which you’d like them to 
appear in your final movie.  
 



 
Figure 4-1. The Storyboard.  

To rearrange your clips on the storyboard, just drag and drop them to a different 
location. 

Edit Your Clips 

Trim your clips to get exactly the footage you need.  

To edit clips: 

8. In the Timeline view, click on the clip you’d like to trim.  

9. In the Preview window, drag the scroll bar slowly and watch as the video 
progresses.  

10. Stop at the point where you want to trim the clip.  

11. On the Clip menu, click Set Start Trim Point.  

12. Now continue to drag the progress indicator until you reach the desired end 
point of your clip.  

 

Figure 4-2. Editing a clip.  

13. On the Clip menu, click Set End Trim Point.  

You will now have your trimmed clip. 

After selecting and editing your clips, you’re ready to add other movie features to your 
timeline. The remaining sections of this chapter will show you how. 



Creating Video Transitions 

With Windows Movie Maker 2 for Windows XP, you can make your home movies look 
more polished and professional by adding video transitions. A video transition 
controls the way one clip or picture in your movie moves to the next. You can add a 
transition between any combination of video clips, pictures, and titles on the timeline 
or storyboard view. 

Transitions are stored in the Video Transitions folder in the Collections pane. 
Windows Movie Maker 2 has over 130 new titles, effects, and transitions. You can 
control the playback duration of a video transition, but it can't be any longer than the 
shorter of the two adjacent clips. Select the clip or picture to which you want to 
transition. Drag it over the clip or picture from which you want to transition on the 
timeline. A cross–fade is the default transition that is automatically added between 
the two clips.  

Any transitions you add appear on the Transition track of the timeline. Expand the 
Video track to see the Transition track. The video transition length, highlighted in the 
square, is determined by the amount of overlap between two clips. 

 

Figure 4-3. A timeline with an added video transition. 



 

Figure 4-4. A project on the storyboard with a video transition. 

To add a transition: 

8. On the storyboard/timeline, select the second of the two video clips or pictures 
that you want to transition between.  

9. On the Tools menu, click Video Transitions.  

Or : 

1. In the Movie Tasks pane, under Edit Movie, click View Video Transitions.  

2. In the Contents pane, double click on the video transitions to preview them.  

3. Select the one you want, click on it, and drag it to the appropriate place on the 
storyboard or timeline.  

4. On the Clip menu, click Add To Timeline or Add To Storyboard.  

You can also add a transition between two clips by going to the Clip menu, clicking 
Add To Timeline or Add To Storyboard. Or, on the storyboard, you can drag and drop a 
transition to the video transition cell between two clips. 

 

 



Adding Video Effects 

Windows Movie Maker 2 for Windows XP makes it easy to add a wide variety of eye–
popping effects to your home movies. 

A video effect determines how a video clip, picture, or title looks in your final movie. 
For example, you might have video that would look great if it had a classic, old–time 
movie look. With Movie Maker, you can add one of the Film Age video effects to give 
it that old–fashioned look. A video effect is applied for the duration of the video clip, 
picture, or title. You can add any of the video effects that appear in the Video Effects 
folder in the Collections pane. 

Video effects are maintained when you split, cut, copy, or move a video clip or 
picture. For example, if you add the Grayscale video effect, and then split the clip, the 
Grayscale video effect is applied to both clips. If you combine two video clips, the 
video effects that were associated with the first clip are applied to the new combined 
clip. The video effects that were associated with the second clip are removed.  

The following illustration shows a project on the timeline with an added video effect. 
An icon appears on the video clip or picture that you applied the effect to. 

 

Figure 4-5. Project on timeline with an added video effect. 

The following illustration shows a project on the storyboard with an added video 
effect. An icon, highlighted in the red square, appears in the video effects cell to 
indicate that a video effect is applied. 



 

Figure 4-6. Project on storyboard with an added video effect. 

To add video effects to your video clips, pictures, or titles:  

14. On the storyboard/timeline, select the video clip, picture, or title that you 
want to add the video effect to.  

15. On the Tools menu, click Video Effects.  

Or: 

16. In the Movie Tasks pane, under Edit Movie, click View Video Effects.  

17. Double-click the effects to see how they look in the preview window.  

18. Drag the effect you want to use onto the clip in the storyboard and place it 
on top of the star in the lower left-hand corner of the clip.  

You can also add an effect by clicking on the effect, then going to the Clip Menu and 
clicking Add To Timeline or Add To Storyboard. 



Adding Titles and Credits 

Windows Movie Maker 2 for Windows XP includes features that make it easy to add 
titles and credits to your movies. You can add any text that you'd like, including the 
title of your movie, your name, the date, and the names of the actors. You can also 
place the titles anywhere you want—at the beginning or end of a movie, before or 
after a clip, or even overlaying a clip. You can also specify the length of time that the 
title will appear. 

 

Figure 4-7. A project with a title that displays before a video clip. 



 

Figure 4-8. A project with displays as an overlay title over a video clip. 

 

Figure 4-9. A project with credits that appear at the end of the project. 



Choosing the Title Animation 

With title animation effects, you can control the way titles play back in your movies. 
For example, the Typewriter title animation displays title text one character at a time. 

Windows Movie Maker includes three categories of title animations:  

• Titles, One Line As the name suggests, the title animations in this category 
are best suited for titles that contain a single line of text. When you select a 
title animation from this category, the text area for entering the title appears 
as one large text box. The text you enter then appears all at once in your 
movie, even if your title actually runs to more than one line of text. 

• Titles, Two Lines The title animations in this category work best for titles 
that contain two or more lines of text. When you pick a title animation in this 
category, you'll see two areas for entering text. The first line of text you enter 
appears first and then the second line of text appears shortly after the first 
line of text is displayed.  

• Credits Movie Maker also makes it easy to add credits to your home 
movies. When a title animation is selected in this category, the text area for 
entering the credits appears as a small grid. Use the top row to enter the title 
of your movie. The rows below provide two columns where you can enter 
information about your movie. You can use the first column for entering titles 
such as director and scriptwriter, and the second column to enter their 
names, for example.  

For each category, if the title will appear as an overlay, you'll see the notation 
(overlay) at the end of the title animation description.  

Entering Titles and Credits 

Here’s how to use title and credit features of Windows Movie Maker 2: 

10. On the Tools menu, click Titles And Credits.  

Or: 

1. In the Movie Tasks pane, under Edit Movie, click Make Titles Or Credits.  

2. On the Where Do You Want To Add A Title? page, click a link that corresponds to 
the place where you want to add the title.  

3. In the Enter Text For Title page, type the text you want to appear as the title.  

4. Click Change The Title Animation, and then on the Choose The Title Animation 
page, select a title animation from the list.  

5. Click Change The Text And Font Color, and then on the Select Title Font And Color 
page, choose the font, font color, formatting, background color, transparency, 
font size, and position of the title.  

6. Click Done, Add Title To Movie to add the title to your movie.  



Adding Music 

Adding a soundtrack is a great way to enhance the meaning and excitement of the 
movies you create. With Windows Movie Maker 2 for Windows XP, it's easy to add 
favorite songs, evocative mood music, or any other audio you'd like to include as part 
of a soundtrack. 

Once you’ve assembled the elements of your home movie on the storyboard, you’re 
ready to add music. Here's how: 

11. In the Tasks Pane, click Import Audio Or Music (or click on File menu, then Import 
Into Collections)  

12. Your My Music folder will open. Navigate to the song that you want and click on 
it, then click the Import button in the lower right-hand corner. This will bring your 
music clip into your collection.  

13. Click on the Show Timeline button above the storyboard, or use the View drop-
down menu and click on Timeline  

14. Drag the audio file down to the Audio/Music track  

15. You can move the audio clip left to right to coincide with a particular video clip. 
And if the music is too long for your video, you can trim it. Simply scroll along the 
Timeline all the way to the right, so you can see the end of the audio clip. Move 
the cursor onto the end of the song, and a red double arrow will appear. Drag the 
clip to the left as far as you want to create the end point of the music.  

 
Figure 4-10. Adjusting the audio. 



You can adjust the volume of the music you add in relationship to and the volume of 
the audio on the video clip. For example, or you can turn the audio track on the video 
clip all the way down so that only the music is heard, or adjust the levels so that both 
are audible.  

To adjust the volume of an audio clip: 

16. On the Audio or Audio/Music track of the timeline, select the audio clip that you 
want to adjust the volume for.  

17. On the Clip menu, point to Audio, and then click Volume.  

18. To adjust the volume, do one of the following:  

• To reduce the volume, move the Audio Volume Level slider to the left.  

• To increase the volume, move the Audio Volume Level slider to the right.  

• To mute the clip, select the Mute Clip check box.  

• To reset the volume to the original volume, click Reset.  

To adjust the volume of an audio clip relative to the audio from the video clip: 

19. Just above the Timeline view, click on the Volume icon on the left.  

20. A slider will appear, and you can drag it left or right, depending on whether you 
want the audio from the video to be more prominent or the music to be more 
prominent.  

 

Figure 4-11. Setting audio levels. 



Adding Narration 

With Windows Movie Maker 2 for Windows XP, you can easily add a voice-over to your 
home movies. Adding narration lets you use your own words and voice to describe 
the scene that viewers are seeing.  

To add voice narration to your movie, you need a microphone installed on your PC.  

Once you’ve assembled the elements of your home movie on the storyboard, you are 
ready to start your narration:  

1. On the View menu, click Timeline (or click Show Timeline in the Storyboard 
section).  

2. Move the playback indicator on the timeline, which appears as a square with a 
vertical line, to a point on the timeline where the Audio/Music track is empty and 
where you want to begin your audio narration.  

3. Click on the microphone icon above the timeline, or go to Tools menu and select 
Narrate Timeline.  

4. To see more options, click Show More Options, and do the following:  

• If you have added other audio clips to the Audio/Music track and you do not 
want the other clips to shift on the timeline, select the Limit Narration To 
Available Free Space On Audio/Music Track check box.  

• In the Audio Device list, click the audio capture device you want to use. Then, 
in Audio Input Source, click the line that you want to use.  

• To adjust the volume of your captured audio, move the Input Level slider to 
the level you prefer.  
 

 

Figure 4-12: Adding narration. 

• Select the Mute Speakers check box to prevent the audio from a video clip 
on the timeline from playing back over your speakers while you are narrating 
the timeline. This keeps unwanted audio from being captured in your 
narration.  

5. Click Start Narration and begin narrating the content on the timeline.  

6. Do one of the following:  

• If the Limit Narration To Available Free Space On Audio/Music Track check 
box is selected, narrate the timeline until the time limit expires.  



• If the Limit Narration To Available Free Space On Audio/Music Track check 
box is cleared, click Stop Narration after you have finished narrating the 
contents on the timeline.  

7. In the File Name box, type a name for your captured audio narration, and then 
click Save.  

The audio narration you captured is imported automatically into the current collection 
and the narration is added automatically to the point on the Audio/Music track where 
the narration was first started. 

Saving and Sharing Movies 

Once you've finished editing, added all the effects, and inserted titles and credits, the 
Save Movie Wizard in Windows Movie Maker 2 for Windows XP makes it easy to save 
your project as a final movie. Timing, layout, and content are all saved as one 
complete movie. You can save and store the movie on your computer or on a 
recordable CD. You can send it as an attachment in an e–mail message. Or upload it 
to a video hosting provider on the Web. You can also choose to record your movie on 
a tape in a digital video camera. Keep in mind that when you save your movie, you 
must decide how to balance quality against file size: the better the quality, the larger 
the resulting file size. 

Options offered by the Save Movie Wizard include: 

• My Computer Choose this option when you want to store your finished 
movie on your PC. You’ll be able to play it back on your computer using 
Windows Media Player. 

 
Figure 4-13. Save a Movie Wizard. 

• Recordable CD Use this option to save your movie to a CD–ROM so your 
friends and family can view it on their own computers. To save movies to a 
CD, you must have a rewriteable or recordable CD drive attached to your 
computer. 

• E–mail If your movie is short, you may want to send it directly in e–mail. 
This option will save your movie as an e–mail attachment. You’ll probably 



want to select a lower bit rate (for example 56 kbps) in order to keep the file 
size down. 

• The Web You can post your movie to a Web hosting provider directly 
through Windows Movie Maker 2. If you don't already have an account at a 
video hosting provider, Movie Maker will walk you through the steps 
necessary to sign up with one of two providers that currently offer free trial 
accounts. Once your movies are posted, simply send a Web address to 
friends and family. 

• DV camera You can also save your finished movie back to the tape in your 
digital video camera when connected through a FireWire cable. This option 
enables you to view your movie on a television (when you connect the 
camera to a TV). 

 


